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INTRODUCTION 

This user manual describes the operation of the CTR family of radio control 
products produced by www.lynovation.com. These products allow the user to 

control amateur radios using Windows  based Pocket PCs running Pocket PC 
2002, Mobile 2003, Mobile 2005, and some Mobile 6 devices (with 320x240 

displays). Connections can be via direct serial, Bluetooth  wireless technology, 
TCP/IP (Internet), and Wifi (wireless TCP/IP). 
 
Products include the following: 
 
CTR-Remote ï radio control software for the Pocket PC 
 
CTR-PC ï Windows based control software for the PC 
 
CTR-Rcvr ï radio control Pocket PC software for the Icom PCR1000 receiver 
 
CTR-PCRcvr ï Windows based PC control software for the Icom PCR1000 
receiver 
 
CTR-Server ï serial port server software for Windows that allows CTR-Remote 
to access a radio connected to a serial port on your PC over a TCP/IP network 
connection 
 
CTR-Bridge ï serial port server software for Windows that allows you to bridge 
multiple TCP/IP network connections to a single serial port 
 
CTR-BlueLync ï a custom designed Bluetooth serial interface for the radio that 
allows you to control your radio wirelessly using the built-in Bluetooth capabilities 
in your Pocket PC or PC 
 

ABOUT THIS DOCUMENT 

Several conventions are used in this document. 
 
Pocket PC is abbreviated PPC 
 
Bold text is used for menu names, menu paths, or button names 

Example: File -> Options -> Set Time means select the Set Time option 
in the Options menu in the File menu 
 

Italics text is used for emphasis to describe programs or special features 
Example: Run the CTR-Server.exe program to enable TCP/IP serial port 
access. 
 

Bold-Italics red text is used for cautions and warnings 
Warning: Always ensure your transmitter is connected to a load before 
transmitting. 
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TRADEMARKS AND TRADE NAMES 

The Bluetooth word mark and logos are owned by the Bluetooth SIG, Inc. and 
any use of such marks by Lynovation is under license. Other trademarks and 
trade names are those of their respective owners. The CTR system 
CTR products are designed to work together to fill a variety of needs for radio 
control. They can also be used separately or with other programs. 
 

CTR-REMOTE 

CTR-Remote is a PPC 2002/2003/2005/Mobile 6 
program written with Microsoft Visual Studio .NET. 
As such, it shares many of the same attributes as 
full Windows based programs. CTR-Remote allows 
you to control many features of your radio with a 
simple point and click interface. Regardless of the 
radio selected, the program has the same look and 
feel.  
 
CTR-Remote can connect to the radio using a 
direct serial connection (if supported by your PPC), 
through a TCP/IP connection using CTR-Server or 
another port serving device, or through a Bluetooth 
connection using a CTR-BlueLync or other 
Bluetooth interface connected to your radio. 
 
NOTE: The Control and DX Clstr tabs were renamed Ctrl and DX in versions 
starting with v2.04.00. Displays in this document may show either notation 
depending on the version used for the screen capture. 

CTR-RCVR 

CTR-Rcvr is a special version of CTR-Remote 
specifically written for the Icom PCR1000 
wideband receiver. It contains all of the 
functionality of CTR-Remote. Since the PCR1000 
is a computer-controlled receiver, CTR-Rcvr also 
provides control for volume, squelch, IF shift, and 
DSP on a separate tab called Lev. It also includes 
a basic bandscope that provides spectrum point-
and-click tuning. 

All of the connection methods in CTR-Remote are 
available in CTR-Rcvr, including Bluetooth 
(requires a special version of CTR-BlueLync) 
making CTR-Rcvr an ideal solution to your 
portable and mobile monitoring needs. 
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CTR-SERVER 

CTR-Server is a Windows program 
that runs on your PC that allows 
you to access a serial port on that 
PC across a TCP/IP connection. 
This connection can be on your 
local network, a Wifi network, or the 
Internet, depending on your needs. 
It is designed to work with all CTR 
software but can also be used as a 
general port server for any program 
requiring access to a serial port. 

CTR-BLUELYNC 

CTR-BlueLync is a 
custom built Bluetooth 
interface based on the 
BlueSMiRF Bluetooth 
module from Spark 
Fun Electronics. 
Models have been 
available for Yaesu, 
Kenwood, Icom 
(including the 
PCR1000), and the 
Elecraft K2. Currently, 
only Yaesu and Icom 
models are shipping. 
 
CTR-BlueLync Keyer is 
the worlds first 
Bluetooth enabled keyer. This module has been discontinued due to lack of 
interest. 

http://www.sparkfun.com/commerce/product_info.php?products_id=582
http://www.sparkfun.com/
http://www.sparkfun.com/
http://www.sparkfun.com/
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NEW FEATURES 

New features are added to CTR products as resources permit. These additions 
will be documented in this section. 

 

Program Version Feature 

CTR-Remote 

CTR-Rcvr 

2.40.00 

1.40.00 

Added support for BlueSMiRF-Gold modules 

Added support for hardware cursor buttons 

CTR-PC 

CTR-PCRcvr 

3.20.00 

3.20.00 

Added support for BlueSMiRF-Gold modules 

 

CTR-Remote 2.20.02 Added support for CTR-BlueLync and CTR-
BlueLync Keyer.  Added ñcar radioò buttons 

CTR-Rcvr 1.10.02 Added support for CTR-BlueLync. Added ñcar 
radioò buttons 

CTR-Remote 2.10.02 Added bandscope feature and fixed several 
bugs 

CTR-Remote 

CTR-Rcvr 

2.04.00 

1.02.00 

Added call sign lookup options to the File menu, 
Edit Log window, and DX-Option menu 

CTR-Remote 

CTR-Server 

2.03.00 

1.01.00 

Added a remote PTT option. Hardware and 
software PTT are supported. Hardware uses 
RTS on the RS-232 port and requires additional 
hardware. 

CTR-Server 1.00.08 Added an option to allow the serial port to 
remain active when in Listen mode. This keep[s 
the Icom PCR1000 radio active when CTR-Rcvr 
is off-line. 
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CTR-REMOTE 

By its very nature, the Pocket PC is a small device with an equally small 
operating system and limited resources. The design philosophy behind CTR-
Remote has always been to control the radio, not manage the radio.  
 
You won't find memory management or many radio-specific features in this 
program. There are simply too many rigs on the market to make this program 
compatible with all of the various features in each rig. 
 
Therefore, CTR-Remote contains a basic set of standard commands that work 
with the Yaesu, Kenwood, Icom, and Elecraft K2 radios. New models are 
continually being added to the list of supported radios on the 
www.lynovation.com web site. 
 
The basic command set includes the following: 

 Set and read the primary VFO frequency 

 Set and read the radio's mode 

 Set the tone/DCS control coding (FM only, depends on manufacturer 
support) 

 Set the transmit offset frequency (FM only, depends on manufacturer 
support) 

 Read the S-Meter (depends on radio model) 

 Read the squelch/unsquelched mode of the radio (depends on 
manufacturer and model) 

FEATURES 

CTR-Remote is optimized for Pocket PC/Mobile 2003/2005 devices with 
integrated Wifi and/or Bluetooth connectivity. It also runs on Pocket PC 2002 
devices and runs on a limited number of Mobile 6 devices.  It supports direct 
serial (if available), Bluetooth, and the TCP/IP connection provided by Microsoft 
ActiveSync and Wifi. 

 Controls Yaesu, Kenwood, Icom, and Elecraft amateur radio transceivers  

 Direct keypad input  

 Supports the ADIF (http://www.hosenose.com/adif) logging format, both 
import and export 

 Easy to use frequency list with priority scan flag  

 DX Cluster connections on TCP/IP and Wi-Fi with auto-tracking and save 
to log features 

 Callsign lookup ï lookup any call on QRZ.com (new in v2.04.00) 

 Lookup calls from the File menu or the Edit Log window 

 Automatically lookup DX cluster spots and display the name/QTH 

 NCDXF/IARU beacon scanning (www.ncdxf.org/beacons.html) 
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 Built-in optional band plan automatically selects the correct mode for the 
selected frequency  

 Band-spread control allows easy fine-tuning  

 Vocal frequency and mode announcements with auto-announce mode  

 History list remembers the last 20 frequencies visited 

 Manage CTR-BlueLync properties (new in v2.20.02) 

 Support CTR-BlueLync Keyer (new in v2.20.02) 

 ñCar radioò button bar allows you to easily select 12 favorite frequencies 
with the click of a button (new in v2.20.02) 

INSTALLATION 

CTR-Remote is installed from a self-installing CAB file. A zip file containing the 
CAB files can be downloaded from http://www.lynovation.com/download_ctr.htm. 
CAB files are named using the version # of the program. 

Example: CTR_v24000_ARM_CABS.zip contains the CAB files for CTR-Remote 
version 2.40.00. 

To install the program: 

1. Unzip the appropriate CAB file using WinZip. There are two CAB files 
supplied. The one you need to use depends upon the version of Pocket PC 
you are running. 
 
a. If you are running Pocket PC 2002, use the ARM file 
b. If you are running Pocket PC/Mobile 2003/2005/6, use the ARM4 file 
 

2. Connect your PPC to your PC using ActiveSync. Use File Explorer or My 
Computer on your PC to copy the CAB file to a folder on your PPC. 
 

3. On your PPC, use File Explorer to select and execute the CAB file. It will self-
extract the CTR.EXE file and all associated support files then install and 
register them. Once the install is compete, the CAB file is automatically 
deleted. 

NOTE: You may get a popup window notifying you that the program you 
installed may not display correctly because it was written for a previous 
version of Pocket PC. Ignore this warning - itôs a Microsoft bug. 

The program is now installed on your PPC. There should be a CTR icon in the 
Start -> Programs menu. You will need to create a new folder (suggested name 
CTR) under My Documents for your frequency lists and log files. 

http://www.lynovation.com/download_ctr.htm
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PROGRAM DESCRIPTION 

Functions 

CTR-Remote has five major functions. Each function is 
on a separate tab. 

Ctrl - choose your radio, connect to it and control the 
frequency, mode, VFO, and scan mode.  

Log - save your contacts in the ADIF compatible log 

List - build custom frequency lists for any application 

DX - monitors and tracks DX activity worldwide 
(requires an Internet connection) 

Key ï supports the CTR-BlueLync Keyer module 

Menus 

File ï the File menu offers the following options: 

 Log ï create, load, and save log files 

 List ï create, load, and save list files 

 DX Clsr ï Open or save DX cluster activity log 
files 

 Options ï define regional defaults (date and 
time formats), set auto-announce and set 
Pocket PC time 

 Callsign Lookup ï lookup callsign info on 
QRZ.com 

 About ï lists program information 

Comm ï the Comm menus offers the following options: 

 Com Properties - select a COM port, TCP/IP 
Address (for Wifi), edit Bluetooth Options (see 
below) 
NOTE: When using a Bluetooth port, select the 
COM port shown as the Outbound port in your 
PPCôs Bluetooth SettingséServiceséSerial 
PortéAdvanced menu. 

 Baud ï set the baud rate or TCP/IP Port. This 
rate should match the baud setting on your 
radio. 
 
NOTE: This option is not available with Roving Network Bluetooth 
modules. Use the ComméCom PropertieséBluetooth OptionséBaud 
listbox to set the baud on these units. 

 Poll Speed ï sets the polling rate while the program is on-line with the 
radio. Poll speed default is 350 milliseconds. You many need to lengthen 
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this time if the s-meter does not update consistently (some radios are 
slow to report s-meter readings). 

 

 PTT Options - two PTT modes are available, Hardware and Software 

o Hardware PTT, the RTS signal on the RS-232 port is controlled by 
the PTT button (additional hardware is required to key the radio) 

o Software PTT, the program sends software commands to the radio 
to control its Tx/Rx mode. 

 Icom Address allows you to change the default address for your Icom 
radio. Use this option if youôve changed your radioôs CI-V address or you 
have a radio that is not yet supported by CTR-Remote (basic commands 
work on all Icom radios with the CI-V interface). 

WARNING: If your connection is lost while you have the radio keyed up 
with either PTT mode listed above, your radio will stay keyed until you 
cycle its power (unless it has an internal PTT timeout timer). 

Other Option Menus are available on each tab to allow you to set specific 
options in those tabs. These menus are described under the tab they appear in. 

Bluetooth Options 

The Bluetooth Options menu selection in Com Properties allows you to select 
and customize your Bluetooth device. 

The BT Type listbox allows you to select the Bluetooth device you are using with 
the program. 

 Generic BT Device: Use this option if you are using a hardware serial 
connection, a generic Bluetooth serial interface, a CTR-BlueLync unit 
with a BlueSMiRF-Silver Bluetooth module, or an original CTR-BlueAir 
device. With this setting, no special configuration commands are sent 
to the serial connection when initializing the port. The Bluetooth 
device must be preset for the radioôs baud rate. 

 BlueRadios: Select this option if you are using an older BlueSMiRF 
Bluetooth module in your CTR-BlueLync. This module will allow you to 
set the serial baud rate on the BlueLync dynamically with the 
ComméBaud menu. These BlueSMiRF modules have FCC Type # 
P00WME-C40 printed on their Bluetooth chip and their green LED 
blinks once per second while off-line. 

 Roving Networks: Select this option if you are using a newer 
BlueSMiRF-Gold Bluetooth module in your CTR-BlueLync. You 
cannot set the serial baud rate dynamically on this device using the 
ComméBaud menu, instead, used the Baud listbox in this window to 
save the serial port baud to flash ram. These BlueSMiRF modules 
have FCC Type # T9JRN41 printed on their Bluetooth chip and their 
green LED blinks twice per second when off-line. 

There are four additional options available for BlueSMiRF modules: 
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 Name ï allows you to change the name of your device. This is the 
name shown in the Bluetooth Browser window.  
NOTE: If you change the device name you must connect to it once 
before the name will update in the PPCôs Bluetooth Browser. 

 Baud ï sets the power-up baud rate of BlueSMiRF module. Use this 
to pre-set the device if you want to use it with other applications.  
NOTE: You must use this control to set the baud rate on a 
BlueSMiRF-Gold module. 

 Tx Pwr ï sets the transmit power on CTR-BlueLync. For the most 
battery life or if you experience shorter distance overload you can set 
this below +15 dBm. This feature is only available on BlueRadios 
based BlueSMiRF modules. 

 Pwr Src ï sets the idle current consumption. Use Normal when 
powered from an external supply. Use Battery to reduce idle current 
from 50 mA to 2 mA. This may cause slower connection response. 
This feature is only available on BlueRadios based BlueSMiRF 
modules. 

Press the Save to Flash button to program your settings into the flash ram in 
CTR-BlueLync. 
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CTRL TAB FEATURES 

The Ctrl tab allows you to control your radio. This section will describe the 
various features of this tab. 

Name, list counter and S-meter 

The name area is used to display identification 
information such as the selected radio, the name of the 
selected frequency from the frequency list, the call sign 
of a DX cluster report, or the cal, location, and power 
level of the current DX beacon in Beacon Scanning 
mode.  

If the frequency is on the frequency list, the memory # 
of the frequency is displayed (M#39 in this example). 

If the program is receiving s-meter replies from the 
radio the s-meter and the bar graph above the 
frequency display will display the value. 

VFO control, Save and Log buttons 

The program has two internal VFOôs. These are not the 
VFOôs provided by many radios. Click the VFO-A 
button to toggle to VFO-B. Click it again to toggle back 
to VFO-A.  

Click the B=A (or A=B if in VFO-B) to set the other 
VFO to the displayed frequency. 

Click Save to save the current settings to the List tab. 
An edit window will allow you to enter a name and 
other information. 

Click Log to save the current settings to the Log tab. 
An edit window will allow you to enter other log 
information. 

Frequency control 

There are several ways to control the frequency of the 
radio. Clicking on the frequency display box will bring 
up a direct entry keypad. A horizontal slider control 
below the frequency display allows you to quickly move 
from one end of the selected band to the other. 
Individual up/down buttons provide direct tuning of the 
1 MHz, 100 kHz, 10 kHz, 1 kHz, 100 Hz, and 10 Hz 
elements. 

Band changes can be made with the up/down buttons 
on the left of the frequency display, or with the band list 
control to the left beneath the horizontal frequency 
scroll bar. 
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Depending on the Scan Mode selected, the up/down buttons on the right of the 
frequency display box scroll the selected frequency, history, or frequency list 
selection. 

The small check box next to the horizontal scroll 
frequency scroll bar turns on band-spread (fine-tuning) 
mode. In this mode the horizontal scroll bar tunes the 

frequency 10x the frequency step selection, just below 
the Scan button (1 kHz in the display above). 

The Scan button toggles the scan mode on/off. The 
color and label of this button changes when scan mode 
is active. Use the Scan Mode control to define the scan 
mode. Other scan options are available in the Scan-
Options menu. 

 

Car Radio Button Bar 

A new car radio style button bar was introduced in 
v2.20.02. Clicking the blue Btn button next to the Lock 
button toggles the display on and off. 
 
The button bar can select on of 12 frequencies. Six are 
assigned to VFO-A and six to VFO-B. Clicking a button 
more than once will toggle the VFO selection and the 
set the frequency to that VFOôs setting. 
 
 
 
There are two ways to set a buttonôs frequency: 
 

1. Click on the upper-left corner of the button to 
set the button to the current frequency and 
mode. The radio will move to whatever 
frequency you ender in the direct frequency 
input window. 
 

2. Click on the lower-right corner of the button to change the buttonôs 
current frequency and mode setting. The radio will not move to the new 
frequency. This is a handy way to check existing programming of the 
button. 
 

NOTE: Set the radioôs mode before editing the button settings. 
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Direct frequency entry 

Clicking on the frequency display box or editing a radio 
button brings up the direct frequency entry keypad. 
Simply enter the frequency and press the OK button.  

For clarity frequencies are shown with and extra 
decimal point between the 1 kHz and 100 Hz element. 

Hint: Enter the frequency in MHz for best results 

The following examples demonstrate direct entryé 

Entering 5 sets to 5.000.000 

Entering 1.1004 sets to 1.100.400 

Entering 10.004 sets to 10.004.000 

Entering 100004 sets to 100.004.000 

Mode and History controls 

The Mode control (far left) has two settings. If the 
checkbox is checked as shown, manual mode control is 
enabled and you can select the radioôs mode from the 
list. If the box is cleared, auto-mode is selected and the 
program decides which mode to use depending on the 
pre-programmed band plan.  

The History control, to the right of the Mode control, 
allows you to select from the last 20 frequencies visited. 
 
 

Resolution and Scan Mode controls 

The Resolution control determines the frequency step 
used in the horizontal frequency scroll bar. It also 
determines the default resolution of the bandscope. In 
this example it is set to 1 kHz. 

The Scan Mode control selects the type of scan to use 
when the Scan button is pressed. There are several 
scan modes. 

Band ï scans the selected band using frequency steps 
defined in the Resolution control (to the right of the 
Scan Mode control) 

Range ï scans the range of frequencies  

Range->Edit allows you to edit the Range of frequencies to scan 

History ï scans the last 20 frequencies visited 

List ï scans the frequencies on the List tab 

List->Priority ï scans the frequencies on the List tab that have their 
Priority flag set 
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DX Clstr ï connects to the selected DX cluster site (defined on the DX Clstr tab) 
and enables DX spot tracking 

Beacon ï enables NCDXF/IAUR Beacon scanning and 
displays the call sign, location and power of the active 
beacon in the Name area.  

Using the Beacon scan option is an excellent way to 
monitor for band openings. 

Beacon scanning can be used on or off-line (off-line 
shown in this example) and works as follows: 

 While scanning for beacons the frequency range 
is restricted to 20, 17, 15, 12, and 10 meters 

 Selecting one of these bands automatically sets 
the radio to the beacon frequency (if on-line) 

 The current call sign, location, and power of the active beacon are 
displayed in the Name area. Each beacon transmits for 10 seconds. First 
it sends its call at 100 watts followed by four one-second key downs, one 
at 100 watts, one at 10 watts, one at 1 watt, and one at .1 watts. 

 There are 18 beacons around the world. The current 10-second interval 
(out of 3-minutes) is displayed in the Note area. In the screen shot above, 
KH6WO transmits during the 0:30 to 0:40 second interval on 20 meters. 

 The key down times are approximate 

 

NOTE: This mode requires the PPCôs internal clock to be accurately set. Several 
programs are available to do this for you, including vxUtil from 
www.cam.com/vxutil_pers.html 

http://www.cam.com/vxutil_pers.html
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Cursor & radio 
frequency 

Scope center 
frequency 

Peak Hold 
button 

Peak Hold 
button 

Scope display 

Scan resolution 

Scope ï enables the bandscope feature (new in v2.10.02). This mode is 
somewhat slow due to the slow s-meter response but may be of some use for 
monitoring band activity. 

There are a few things to know about the bandscope: 

1. The resolution of the scope is determined by the Resolution 
control. 

2. The frequency of the main display is the center frequency on the 
scope. 

3. The current frequency being scanned will be shown in the Name 
area of the display. 

4. Clicking on a signal on the scope will automatically move the 
scope center to that frequency and pause the scan for the Scan 
Pause setting (in the Scan-Options menu). 

5. There are two option buttons at the right of the scope.  

a. Clicking the top button (-) turns on the Peak Hold feature 
(^). The highest signal received at each frequency will be 
held on the display.  

b. Clicking on the bottom button (*) turns on the Zoom 
feature (Z). In this mode, the resolution is increased by a 
factor of 10 so the scope scans the band faster. 
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Play, Lock, and Btn 

The Play button vocally announces the frequency and 
the mode. You can set the program to auto-announce 
these values by selecting File->Options->Auto-
Announce. 
 
NOTE: You can record your own audio announcement 
files. Simply record new .WAV files for each .WAV file in 
the CTR folder on your PC. 

The Lock button locks all CTR-Remote controls. This 
permits you to carry your PPC in your pocket and not 
worry about changing program parameters. Click the 
Lock button again to unlock the controls. 

The Btn button toggles the car radio button bar. 

 

FM Options 

A special set of options is available when FM mode is 
selected. These options allow you to set the Transmit 
Offset and tone coding options. 

The Transmit Offset is entered into the Tx Offset box 
on the left and is entered in MHz. 

NOTE: Tx Offset is not supported on all radios. 

The Tone Mode option box (middle) allows you to 
select the tone option to use. The options are None, 
Tone Encode (T-Encode), Tone Encode and Decode 
(T-Enc/Dec) and DCS. Which options are available 
depends on the radio model. 

When a tone mode is selected, the tone frequency selection list box (on the right) 
allows you to choose the tone frequency. This option sets both transmit and 
receive tones to the same frequency if T-Enc/Dec is selected. Only tone 
frequencies available on the selected radio are shown. 

If DCS (Digital Coded Squelch) is available and selected, choose the DCS code 
from the right-hand list box. 

NOTE: Most radios do not support reading Tx Offset and Tone Mode 
settings from the radio. Therefore, the options listed above only set the 
modes on the radio. When first displayed, they will have default values in 
them regardless of the settings programmed into the radio. 
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Radio Selection and On-line Control 

Radio selection is done by first selecting the 
manufacturer then the model.  

Kenwood and Elecraft radios do not have a Model list. 
Kenwood radios contain an ID# so the program can 
determine the model # automatically and the K2 radio is 
the only radio supported in the Elecraft line. 

NOTE: Selecting an Icom model sets the radio address 
to the default value. You can override this value in the 
Comm->Icom Adrs menu if needed. 

Once you have selected the correct radio, click the On-
line box to begin polling the radio. Once on-line, the 
VFO buttons above the frequency display will be visible. 

Warning! 
Make sure you select the correct model. Certain commands on some 
models may lock up other models requiring you to either remove 
power from the radio and/or reset it to its factory default values.  

On-line Polling 

The Polling Speed in the Comm menu sets the rate at which the program polls 
the radio for changes. The default is 350 milliseconds. You can increase this 
value if you find the s-meter does not update or the polling adversely affects the 
operation of your radio. Decreasing this value does not affect the actual polling 
rate since the program takes about 250 milliseconds to update between polls. 

NOTE: Not all radio protocols support s-meter. If the program does not update 
the s-meter graph, check your radioôs documentation to see if it supports the s-
meter. If it does, you may need to adjust the Polling Time in the Comm menu. 

Scan-Options Menu 

The Scan-Options menu allows you to control how the 
program reacts in Scan mode. 

Scan Speed sets the scanning rate 

Scan Pause sets the amount of time the program waits 
in Pause mode 

Unsqueched determines if Scan pauses for the Scan 
Pause time, holds, or stops when it detects the radio is 
unsquelched. 

S-Mtr determines if Scan pauses for the Scan Pause 
time, holds, or stops when the s-meter is equal to or 
greater than the S-Mtr >= the trigger threshold, also set 
in this menu. 

In the example display, the scan speed is 500 milliseconds and it will pause for 5 
seconds if the s-meter is >= 6. 
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NOTE: These options may not work on all radios since not all radios support s-
meter reads or squelch status. 

LOG TAB FEATURES 

This tab provides a basic logging tool to track your 
QSOs. Log files are saved in ADIF format so they are 
compatible with all major PC logging programs. ADIF 
formatted files can also be loaded directly into CTR-
Remote, but be aware that critical information may be 
parsed out of them and not resaved. 

The intent of the CTR-Remote log is not to replace your 
current logging software. Rather, to provide a 
convenient method to log contacts while portable or 
mobile (when parked of course!).  

The log supports the following parametersé 

QSO Date and Time 
(UTC)  

Call sign Contest ID 

Frequency Mode Contest Tx SN 

Power RST-Sent Contest Rx SN 

QTH RST-Received Four user 
selectable fields 

Name Comments (QSO notes)  

QSL-Sent QSL-Received  

Log Editing 

The Log-Options menu allows you to Add, Edit, or 
Delete an entry. Selecting Add or Edit brings up the log 
edit window where you can enter specific contact 
information. 

When finished editing click the OK button. To exit 
without saving your changes click the Cancel button. To 
delete the current selection, click the Delete button. To 
move to other entries in the log, use the Left/Right 
Arrow keys. To save the current entry without exiting 
the edit window, click the Apply button. 

Hint: Clicking the yellow [*] button next to the Dt/Tm 

(Date/Time) or Freq boxes updates that data to the current value. Clicking the [*] 
button next to Call will lookup the call in the QRZ.com database and display the 
results. You can choose to import the name and QTH data from the lookup into 
your log entry. 
Note: You can add or edit a log entry from the Log-Options menu or by clicking 
the Log button on the Ctrl tab. 


